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1. Release description 

Freescale, a subsidiary of NXP Semiconductors, is 

pleased to announce the release of the S32 Design 

Studio for Power Architecture v1.2 for Automotive and 

Ultra-Reliable MCUs. The S32 Design Studio is based 

on the Eclipse open development platform and 

integrates the Eclipse IDE, GNU Compiler Collection 

(GCC), GNU Debugger (GDB), and other open-source 

software to offer designers a straightforward 

development tool with no code-size limitations. 

1.1. Release content 

• Eclipse Luna 4.4 Framework 

• GNU Build Tools for e200 processors (support 

VLE and BookE ISA, based on gcc 4.9.2, 

binutils 2.25 and gdb 7.8.2) 

• Libraries included: newlib, newlib-nano and 

Freescale EWL2 

• P&E Multilink/Cyclone/OpenSDA  (with P&E 

GDB Server) 

• New Project wizard to create application and 

library projects for supported devices 

• Peripherals Register and Special Purpose 

Registers View 

• Graphical tool for creating SPT algorithms 

• SDK management included: 

— FreeMASTER Serial Communication driver 2.0 

NXP Semiconductors Document Number: S32DSPA1.2  

Release Notes Rev. 1.2 , 06/2017 

Contents 

1. Release description ............................................................ 1 
1.1. Release content ....................................................... 1 

2. What’s New ....................................................................... 3 
2.1. New Device Support ............................................... 3 
2.2. New Features .......................................................... 3 
2.3. Bug Fixes ................................................................ 3 

3. System Requirements for Windows Host .......................... 4 
3.1. Recommended Configuration ................................. 4 
3.2. Operational Minimum Configuration ..................... 4 
3.3. Host Operating System Support .............................. 4 

4. System Requirements for Linux Host ................................ 4 
4.1. Recommended Configuration ................................. 4 
4.2. Operational Minimum Configuration ..................... 5 
4.3. Host Operating System Support .............................. 5 

5. Product WEB page ............................................................. 5 
6. Installation and Licensing .................................................. 5 
7. Technical Support .............................................................. 6 
Appendix A. Known issues and Workarounds ...................... 7 
Appendix B. Performance Considerations ............................ 9 



Release description 

S32 Design Studio for Power Architecture v1.2, Release Notes, Rev. 1.2, 06/2017 

2  NXP Semiconductors 

• GreenHills and Diab compilers1 support by new project wizard 

• Lauterbach, PLS and iSystem debuggers support by new project wizard 

• Kernel Aware debugging for FreeRTOS, eCOS, OSEK. 

• Devices supported: 

— S32R274  

— S32R372 

— MPC5775K, MPC5774K 

— MPC5746R, MPC5745R, MPC5743R 

— MPC5777M 

— MPC5777C 

— MPC5748G, MPC5747G, MPC5746G 

— MPC5746C, MPC5745C, MPC5746D, MPC5746B, MPC5745D, MPC5745B 

— MPC5744P, MPC5743P, MPC5742P, MPC5741P 

— MPC5601P, MPC5602P, MPC5603P, MPC5604P 

— MPC5644B, MPC5644C, MPC5645B, MPC5645C, MPC5646B, MPC5646C 

— MPC5601D, MPC5602B, MPC5602C, MPC5602D, MPC5603B, MPC5603C, 

MPC5604B, MPC5604C, MPC5605B, MPC5606B, MPC5607B 

— MPC5606S 

— MPC5604E 

— MPC5644A 

— MPC5643L 

— MPC5676R 

— MPC5632M, MPC5633M, MPC5634M 

— MPC5642A 

— MPC5674F 

— MPC5673K, MPC5674K, MPC5675K 

 

 
 
 
 
1 The plugins to support 3rd party compilers or debuggers are not included and have to be installed from 
corresponding update site or installation 
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2. What’s New 

S32 Design Studio for Power Architecture v1.2 addresses a number of defects and new features: 

2.1. New Device Support 

Support for the following devices added: 

• MPC5632M, MPC5633M, MPC5634M 

• MPC5642A 

• MPC5674F 

• MPC5673K, MPC5674K, MPC5675K 

• S32R372 

2.2. New Features 

• Compiler update – see details in compiler release notes in Cross_Tools\powerpc-eabivle-4_9 

• View for the Special Purpose Registers added 

• Improvements for Peripherals Register view 

• Added support for Semihosting/Debug console for single core devices 

• RESET functionality added, the hardware reset2 is executed for main/boot core and individual 

core reset for secondary cores. 

• Improvements for SPT diagram to display instruction labels and key parameters 

• SDK mechanism improvements to support SDK per build configuration 

• FreeMaster Serial Communication driver 2.0 integrated 

• iSystem debugger support added to New Project Wizard 

• SPT assembler update 

• Updated P&E debug plugins and drivers to the latest and greatest versions  

2.3. Bug Fixes  

• Project Explorer issue with incorrect display of the resources excluded in some build 

configuration fixed 

• Updated header and register description files to fix issues and synchronize with latest Ref 

Manual versions 

 
 
 
 
2 As the hardware reset clear RAM, the executable code will be lost for RAM configuration. 
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3. System Requirements for Windows Host 

3.1. Recommended Configuration 

• PC with 2.6 GHz Intel® Pentium® compatible processor or better 

• 4 GB of RAM  

• 4 GB of disk space (when installing full product or updates) 

• 3 GB on Windows system disk  

• USB port for communications with target hardware 

• Ethernet port for communications with target hardware (optional) 

3.2. Operational Minimum Configuration 

• PC with 1.8 GHz Intel® Pentium® compatible processor 

• 2 GB of RAM  

• 3.6 GB of disk space (when installing full product or updates) 

• 3 GB on Windows system disk  

• USB port for communications with target hardware 

3.3. Host Operating System Support 

• Microsoft Windows 7 32-bit and 64-bit (Home Premium Edition and Professional Edition) 

• Microsoft Windows 8 32-bit and 64-bit (Home Premium Edition and Professional Edition) 

• Microsoft Windows 8.1 32-bit and 64-bit (Home Premium Edition and Professional Edition) 

• Microsoft Windows 10 32-bit and 64-bit (Home and Pro Editions) 

4. System Requirements for Linux Host 

4.1. Recommended Configuration 

• PC with 2.6 GHz Intel® Pentium® compatible processor or better 

• 4 GB of RAM  

• 4 GB of disk space (when installing full product or updates) 

• 3 GB in /tmp directory  

• Java 1.8 

• USB port for communications with target hardware 

• Ethernet port for communications with target hardware (optional) 
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4.2. Operational Minimum Configuration 

• PC with 1.8 GHz Intel® Pentium® compatible processor 

• 2 GB of RAM  

• 3.6 GB of disk space (when installing full product or updates) 

• 3 GB in /tmp directory   

• Java 1.8 

• USB port for communications with target hardware 

4.3. Host Operating System Support 

• Ubuntu 14.04  64-bit 

• Debian 8  64-bit 

• CentOS 7  64-bit 

5. Product WEB page 

S32 Design Studio for Power Architecture v1.2 product page is http://www.nxp.com/S32DS. It contains 

general information about this product, updates, and download links. 

6. Installation and Licensing 

To install S32 Design Studio for Power Architecture v1.2, choose the download option that meets your 

needs. 

 

The installer package contains the complete S32 Design Studio for Power Architecture v1.2 suite and an 

installer. All data needed by the installer will be downloaded and no other download will be performed3. 

Run the installation package and a wizard will guide you through the installation process.   

During installation the license activation will be requested. The following types of activation supported: 

• Online activation, requires the internet access and request for license will be sent automatically 

• Offline activation, no internet access required, the offline activation request is generated and 

should be passed to licensing site to get the activation response, which should be loaded back to 

installer. 

 

 
 
 
 
3 The plugins to support 3rd party compilers or debuggers are not included and have to be installed from 
corresponding update site or installation 

http://www.nxp.com/S32DS
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New functionality including support for new devices can be added to S32 Design Studio for Power 

Architecture v1.2  with service packs, updates and patches. Service packs add specific support for new 

devices. Updates and patches correct software defects and add general functionality affecting more than 

one device family.  

 

New support can be added directly from the Internet or from a downloaded archive. If your computer is 

connected to the Internet, select Install New Software in the Help Menu and all available updates will be 

displayed. If your computer does not have Internet access, you can download the archive that contains 

the service pack, update or patch you need from product page and follow the Service Pack Updater 

procedure posted on the site.  

7. Technical Support 

S32 Design Studio issues are tracked through the S32DS Public NXP Community space: 

https://community.nxp.com/community/s32/s32ds . 

 

For confidential cases and cases which cannot be publicly shared on NXP Community please follow the 

steps described here: 

https://community.nxp.com/docs/DOC-329745 

 

 

 

https://community.nxp.com/community/s32/s32ds
https://community.nxp.com/docs/DOC-329745
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Appendix A. Known issues and Workarounds 

  

• Conditional watchpoints and breakpoints: Conditional breakpoints and watchpoints, including 

those using ignore counts, do not work always. 

Workaround:  do not use conditions for breakpoints and watchpoints, instead check for 

condition in the code and set a normal breakpoint. 

• ATTENTION:  If the linker file being used in your project is missing the KEEP (*(.init) and 

KEEP (*(.fini)) statements (see example below), the initialization code will not have closing 

statements and will not return to main. 

Workaround:  Update the linker file to include the statements.  Any newly created projects will 

include the necessary and required statements in linker file.   

Recommendation:  Create a  new project for the corresponding device, compare and add 

missing statements. 

SECTIONS 

{ 

  ... 

    .text : 

     { 

      … 

      KEEP (*(.init)) 

      KEEP (*(.fini)) 

      … 

NOTE 

The projects created by older version of S32DS will be detected during 

opening and automated fix will be proposed.  

• Uninstallation of P&E drivers: The P&E Device Drivers item will remain in the Control Panel/ 

Programs and Features after uninstallation of S32 Design Studio, if user will try to use this item 

to uninstall – error message appeared, the user should ignore it. But the drivers will remain in the 

system. 

Workaround: P&E drivers should be uninstalled before the product uninstallation. But one 

should be careful if several products are using P&E drivers. 

• Debugger  might fail for MPC5777M when stopped on main() and memory window opened at 

address 0xFFE68000 and step performed (before initialization done).  

Workaround: Open memory window at that address after xcptn_xmpl() is executed. 

• Disassembly view  content might be destroyed occasionally.  

Workaround: Close disassembly view and open it again using menu  Window → Show View 

→ Disassembly. 

• USB driver conflict between P&E and Xilinx software: P&E Drivers for Windows utilize the 

3rd party service Jungo WinDriver to enable USB support under windows XP/7/8.x/10. Xilinx 

also uses WinDriver for their driver packages, but older versions. Starting with the P&E Driver 

package 11.7, a conflict between P&E Drivers and software IDES that rely on older Jungo driver 

packages might occur. This is because both the old and new driver packages utilize the same .sys 
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file (windrvr6.sys). When the new P&E Drivers are installed, Xilinx tools stop working after 30 

days because the new sys file requires a new license that the older Xilinx software does not have. 

Workaround: Please follow the steps in P&E's FAQ 255 for installing an older version of P&E 

Drivers (11.1) to resolve Xilinx conflict under Windows XP/7/8.x. 

http://www.pemicro.com/website_management/faq_view.cfm?id=225   

If drivers issue persists, please submit a support request to P&E Microcomputer Systems: 

http://www.pemicro.com/support/index.cfm   

• Missing license could be reported on IDE start. 

Workaround: same activation ID should be entered. 

• Problems could be experienced while debugging of elf file generated by GHS compiler like 

missing call stack information, incorrect info on step into function, etc. 

Workaround: On occasion GHS generates GDB incompatible debug information preventing the 

debugger from displaying the call stack. In some cases, without such information gdb can still 

debug your program. The program build needs to be augmented with a post-build step, select the 

project in the project explorer view and File->Properties to display the project properties, under 

C/C++ Build -> Settings select the build steps tab and enter the command gstrip –

r=.debug_frame executable. Switch to Instruction Stepping Mode to be able to step through 

function.  If this workaround does not help – please report issue to GreenHills support. 

• Hyperlinks might not work correctly under Windows 10 when Microsoft Edge is default 

browser 

Workaround: Set another browser as default. 

• SPE2 support limitations by compiler: SPE2 intrinsic functions are not implemented.  

Workaround: Use inline assembler 

• SPE2 support limitations by tools: Disassembler doesn’t show SPE2 instructions mnemonics. 

Workaround: None. Only opcodes are displayed 

• LSM or DPM device mode selection for MPC5643L: MPC5643L device provides user with 

capability to configure the processor to boot up in Lock-Step Mode (LSM) or Dual-Processor 

Mode(DPM) out of reset. One is required to re-flash a dedicated control byte in shadow block of 

FLASH memory to switch back and forth between LSM and DPM modes 

Workaround: This can be safely achieved by using a dedicated FLASH programming algorithm 

within evaluation version of PROGPPCNEXUS FLASH programming software from P&E 

Microcomputer Systems. Please refer to the following FAQ for a download link and step by step 

LSM/DPM mode switching directions - 

http://www.pemicro.com/website_management/faq_view.cfm?id=227  

 

NOTE 

There are some issues which are introduced by CDT therefore reproduced 

in S32 Design Studio. Those issues might be fixed when the fix is 

available with newer CDT version and when S32 Design Studio migrates 

to it.  

 

http://www.pemicro.com/website_management/faq_view.cfm?id=225
http://www.pemicro.com/website_management/faq_view.cfm?id=227
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Appendix B. Performance Considerations 

The following suggestions will help keep the S32 Design Studio tools running at a respectable 

performance level. 

1. To maximize performance, the S32 Design Studio tools should be installed on a computer with 

the recommended system configuration. While the tools will operate on a computer with the 

minimum configuration, the limited hardware will restrict its ability to function at desired 

performance levels. 

2. Close unused projects. Eclipse caches files for all open projects in the workspace. If you need 

multiple projects open, try to limit the number of projects to no more than 10. 

3. The Eclipse IDE provides several options that provide user assistance tools. These options, 

however, use memory and cpu bandwidth. If performance is slow and you do not need these 

options, turn them off.  

• Scalability options configure how eclipse deals with large source files. 

— Scalability options: 

– Editor live parsing: impacts parsing while typing, Outline View, semantic highlighting, 

folding, etc. 

– Semantic highlighting: C/C++ identifiers are colored 

– Syntax coloring: coloring of keywords, comments and literals 

– Parsing–based content assist proposals: content assist proposals which require parsing 

the file  

– Content assist auto activation: content assist activated automatically on trigger 

sequences, like '.', '::' or '–>'. 

— To disable 

– Click menu ‘Window’ –> ‘Preference’  

– Expand ‘C/C++’ –> ‘Editor’ –> ‘Scalability’ 

– Uncheck ‘Enable all scalability mode options’ 

• Content Assist Auto Activation can reduce the number of keystrokes a developer must type to 

create code. The Content Assist plug-in consists of components that predict what a developer 

will type, based on the current context, scope and prefix. 

— To disable: 

– Click menu ‘Window’ –> ‘Preference’  

– Expand ‘C/C++’ –> ‘Editor’ –> ‘Content Assist’ 

– Uncheck all the options for ‘Auto-Activation’  
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